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Parking Tickets Module

Overview

Summary

The Parking Tickets module is a comprehensive citation management tool. The processes

included in this module allow you to record citation details, receive ticket related fines, gen-

erate past due notification letters, and initiate the collections process.

Each object in the flowchart below represents a process in the application.
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PT> Collections

Processing a Collections Batch

Summary

The Collections batch process allows you to charge late fees, automatically update the

status of selected parking tickets, and generate collections letters.

Step by Step

1     Create or open a collections batch in the Parking Tickets module. 

l Select the Collections palette in PT> Collections. This will expand the Collections

palette and display the steps of the batch process.

l Modify an existing batch or create a new Collections batch.

l Select a batch number from the drop-down menu at the top of the Collections

palette to select an existing batch.

l Select New from the Collections batch number drop-down menu to create a

new batch. This will open the New Batch window.

l If there are open batches in the Collections process, you can create a new

batch without affecting the open batches.
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l Enter a Batch Month and Batch Year. These fields default to the current cal-

endar period and are for reference only. The fiscal period of the transactions

in the batch is determined by the transaction date entered during the Gen-

erate step.

l
Click the Generate icon to populate the Batch Number field with the next

available batch number. Batch numbers are limited to five digits and must be

unique within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number

and clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the Collections palette

and press DELETE to delete a batch. Any uncommitted transactions in the batch

will be deleted.

2     Generate the notices. 

l Open the Generate PT Collections window (PT> Collections> Generate).

l Check the Fee toggle for each fee you would like to send to collections.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed Fees. All Fees are selected by default.

l These icons can be used to select or deselect the Statuses as well.

l Fees are created and maintained on the Fee Maintenance window (PT> Main-

tenance> Fees).
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l Check the Status toggle for each status you would like to send to collections.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l Specify a Tran Date for the Collections batch. This date will be used by the Letter

and Penalty transactions created when the batch is committed.

l Specify an Aging Date for the batch.

l The Aging Date is the date the system will use in conjunction with the Min-

imum Age and Maximum Age fields to determine which tickets are to be put

into Collection status.

l For example, if 10/15/15 was entered as the Aging Date, and 30 and 60

are entered in the Minimum/Maximum fields, all citations with a date

between September 15th (30 days old) and August 16th (60 days old)

would be selected to for the collections batch.

l Enter a New Ticket Status or click the field label to select a status from a list.

l This is the status that will be automatically assigned to any citations included

in the collections batch. This will default to the collections status specified on

the PT Setup window (PT> Utilities> Setup> Collections Status field).

l The Filter tab is used to filter the citations that will be included in the Collections

batch.

l The Minimum Age and Maximum Age fields are used to filter the included

citations by their age in relation to the Aging Date specified above.

l The Minimum Status Age field is used to specify the minimum number of

days that a citation must have been in its current status, such as "Past Due",

in order to be included in the current collections batch.
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l The Ticket tab is used to add specific parking tickets to the collections batch.

l
Click the Create icon to select specific parking tickets to include in the

batch. This will launch the Parking Ticket Selection window.

l
Filter the displayed tickets and click the Confirm icon when you have

made your selection. You can use the CTRL or SHIFT keys to select multiple

tickets.

l Manually selecting parking tickets to include in the batch will override any fil-

tering details specified on the Filter tab.

l
Click the Save icon when compete.

3     Edit the PT Collections. 

l Open the Edit Collections window (PT> Collections> Edit).

l The Ticket tab of the Edit Collections window displays all of the tickets that will be

included in the Collections batch.

l Click a citation number to open and edit the included ticket.

l
Highlight a ticket and click the Delete icon to remove the ticket from the

batch.

l The Errors tab will display any tickets that meet the filter requirements specified in

the Generate step but cannot be included in the Collections batch. The Warning

Message column will display the reason that the ticket cannot be included in the

batch. Tickets that meet one of the following criteria cannot be included in a
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Collections batch:

l Citation is in a pending Cash Receipts batch.

l Citation is in another pending Collections batch.

l Citation is in a pending Past Dues batch.

l Citation was manually included in the Collections batch but has no out-

standing balances that qualify for collections.

l
Click the Save icon when compete.

4     Print the Proof List. 

l Open the Proof List window (PT> Collections> Proof List).

l Select a Report Type from the drop-down menu.

l The Summary report will display the Name, Vehicle Year, Make, Model, Tag

Number, Tag Expiration Date and Amount. The report will also include a

report total and the number of printable notices generated.

l The Detail report will display everything included in the Summary report as

well as the Citation Number, Citation Date and Location for each included

ticket.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).
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l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the Collections Letters. 

l Open the Letters window (PT> Collections> Letters).

l Select a Form from the drop-down menu. If a default form is specified on the PT

Setup window (PT> Utilities> Setup> Collections Form field), that form will auto-

matically populate and this field will not be enabled.

l The format and information included in the Collections letters is determined

by which form is selected.

l Forms are created and maintained on the Forms Maintenance window (PT>

Maintenance> Form).

l The Tran Date field will populate with the transaction date specified in the Generate

step.
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l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Generate the optional Collection Agency Report and Export file. 

l Open the Collection Agency Report window (PT> Collections> Collection Agency

Report).

l The Collection Agency Report is very similar to the Collections Proof List in

that it provides the general citation information for each parking ticket

included in the batch.
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l Select a Report Type from the drop-down menu.

l The Summary report will display the Name, Vehicle Year, Make, Model, Tag

Number, Tag Expiration Date and Amount for each ticket included in the

batch. The report will also display a report total and the number of printable

notices generated.

l The Detail report will display everything included in the Summary report as

well as the Citation Number and Citation Date.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

l Open the Collection Agency Export window (PT> Collections> Collection Agency

Export).

l The generated export file will include the information displayed on the Col-

lection Agency Report as well as the address information for the cited drivers.

PROCESSING A COLLECTIONS BATCH 11



l The export file must be in comma-separated value (.csv) format. The exported file

will include the Citation Number, Citation Date, Location, Violation Description, Last

Name, First Name, Address, City, State, Zip, Plate Number, Make and Amount Due

for each included parking ticket.

l
Click the Confirm icon when complete to create the export file.

l You can view the progress of the export on the Job Viewer window (SS> Util-

ities> Show Scheduled Jobs).

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the collections file.

l Check the Open toggle if you would like to open the exported file after it is

saved locally.

l
Enter the export path location and click the Save icon to export the file to

the local path.

7     Commit the Collections batch. 

l Open the Commit window (PT> Collections> Commit).

l Click OK to commit the batch.

l If a citation included in the Collections batch has been added to a Cash

Receipts batch between the time when the Collections batch was generated

and when you are attempting to commit the batch, a warning message will dis-

play and the batch will need to be regenerated.
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l Once the batch is committed, the status of the tickets included in the batch will be

updated to the Collections status specified on the Generate step. Each ticket will

also be updated to include the Collections Alert specified on the PT Setup window

(PT> Utilities> Setup> Collections Alert field).
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PT> Excessive Tickets

Processing Excessive Tickets

Summary

The Excessive Tickets batch process is used to generate notices for individuals that have

been cited for more than a specified number of parking violations. This process can also be

used to update the status on the included parking tickets.

Step by Step

1     Open or create an Excessive Tickets batch. 

l Select the Excessive Tickets palette in PT> Excessive Tickets. This will expand the

Excessive Tickets palette and display the steps of the batch process.

l Modify an existing batch or create a new Excessive Tickets batch.

l Select a batch number from the drop-down menu at the top of the Excessive

Tickets palette to select an existing batch.

l Select New from the batch number drop-down menu to create a new batch.

This will open the New Batch window.
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l If there are open batches in the Excessive Tickets process, you can create a

new batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current cal-

endar period and are for reference only. The fiscal period of the transactions

in the batch is determined by the Journal Entry Date entered during the Gen-

erate step.

l
Click the Generate icon to populate the Batch Number field with the next

available batch number. Batch numbers are limited to five digits and must be

unique within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number

and clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the Excessive Tickets

palette and press DELETE to delete a batch. Any uncommitted transactions in the

batch will be deleted.

2     Generate the Excessive Tickets batch. 

l Open the Generate Excessive Tickets window (PT> Excessive Tickets> Gen-

erate).

l Select each Status that you would like to include in the Excessive Tickets batch.

l
Click the Select All or Deselect All icon to select or deselect all of the

displayed statuses. All statuses are selected by default.
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l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l Enter the Tran Date for the batch.

l This is the date that will be associated with the Excessive Ticket Letters trans-

actions that are created when the batch is committed. This is also the date

that will populate the Excess Date field on the included citations.

l The Minimum Vehicle Tickets field is used to specify how many tickets will be

deemed excessive for the current batch. Only those vehicles or people that meet or

exceed this number of tickets will be included in the batch.

l The system will include all unpaid tickets of the selected statuses when cal-

culating the number of tickets. This includes tickets that have already been

marked as excessive.

l The New Ticket Status field is used to specify the new status that each ticket

included in the batch will be updated to when the batch is committed.

l This field will automatically populate with the status specified on the PT Setup

window (PT> Utilities> Setup> Excessive Ticket Status field).

l Check the Resend notices if already marked excessive toggle if you would like

to resend excessive tickets letters for any included tickets that have already be

marked as excessive.

l The Ticket section is used to manually add specific tickets to the batch.

l
Click the Create icon to add a ticket to the batch. This will launch the Park-

ing Ticket Selection window.

l
Highlight the desired tickets and click the Confirm icon to add them to the

batch.
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l Press SHIFT or CTRL while selecting tickets in order to add multiple

tickets to the batch.

l If individual tickets are added to the excessive tickets batch, all other filter

details specified on the Generate window will be disregarded. Only the selec-

ted tickets will be processed.

l
Highlight a ticket and click the Delete icon to remove it from the excessive

tickets batch.

l
Click the Confirm icon to generate the excessive tickets batch.

3     Edit the Excessive Tickets batch. 

l Open the Edit window (PT> Excessive Tickets> Edit).

l The Ticket tab of the Edit window will display all the tickets included in the excess-

ive tickets batch. Each included ticket can be reviewed and modified before pro-

ceeding. This is an optional step.

l
Highlight a ticket and click the Delete icon to remove the ticket from the

excessive tickets batch.

l The Errors tab will display all of the tickets that met the filtering requirements of the

Generate step but cannot be included in the excessive tickets batch.

l The Warning Message column will display the reason that the ticket cannot be

included in the batch. Tickets that meet one of the following criteria cannot be

included in an excessive tickets batch:

PROCESSING EXCESSIVE TICKETS 17



l Citation is in a pending Cash Receipts batch.

l Citation is in another pending Excessive Tickets batch.

l Citation was manually included in the Excessive Tickets batch but has

no outstanding balances.

l
Click the Save icon if any changes were made during the edit step.

4     Print the Excessive Tickets Proof List. 

l Open the Proof List window (PT> Excessive Tickets> Proof List).

l Select a Report Type from the drop-down menu.

l The Summary report will display the Name, Vehicle Year, Make, Model, Tag

Number, Tag Expiration Date, number of Tickets and Amount. A report total

will also be provided.

l The Detail report will display everything included in the Summary report as

well as the Citation Number, Citation Date and Location.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.
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l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the Excessive Tickets Letters. 

l Open the Letters window (PT> Excessive Tickets> Letters).

l Select a Form from the drop-down menu. If a default form is specified on the PT

Setup window (PT> Utilities> Setup> Excessive Tickets Form field), that form will

automatically populate and this field will not be enabled.

l The format and information included in the Excessive Tickets letters is determ-

ined by which form is selected.

l Forms are created and maintained on the Forms Maintenance window (PT>

Maintenance> Form).

l The Tran Date field will populate with the transaction date specified in the Generate

step.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.
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l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the Excessive Tickets batch. 

l Open the Batch Commit window (PT> Excessive Tickets> Commit).

l Click the OK button to commit the batch.

l If a citation included in the excessive tickets batch has been added to a Cash

Receipts batch between the time when the excessive tickets batch was gen-
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erated and when you are attempting to commit the batch, a warning message

will display and the batch will need to be regenerated.

l Once the batch is committed, the status of the tickets included in the batch will be

updated to the status specified on the PT Setup window (PT> Utilities> Setup>

Excessive Tickets Status field).
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PT> Maintenance> Alert Code

Alert Code Maintenance

Summary

Alert codes can be set up to alert users when they select and edit a parking ticket from

within the PT module or when the parking ticket is accessed via the Cash Receipts inter-

face. The alert window will display the system that the parking ticket was accessed from,

the alert code, the expiration date for the alert code, and any comments added to the alert

code. When the user closes the alert window, the parking ticket that they selected will

open.

The PT module can also be set up to automatically attach a collections alert code to park-

ing ticket when that ticket is pulled into a collections batch. When the parking ticket is paid

through Cash Receipts, the collections alert will automatically be removed from the tick-

et.The collections alert is specified on the PT Setup window (PT> Utilities> Setup> Col-

lections Alert field).

The alert code details specified when the alert code is created are used only as a template.

These details can be edited when the alert code is attached to a parking ticket. Because

these details can be edited on each ticket, any changes made to an alert code on the Alert

Code Maintenance window will not automatically update on the parking tickets that the

edited alert code was previously attached to.

ALERT CODE MAINTENANCE 22



Step by Step

1     View the existing alert codes.

l Open the Alert Code Maintenance window (PT> Maintenance> Alert Code).

l The left section of the window will display all of the alert codes that have been cre-

ated in the application. Select an alert code in the left section of the window and the

information attached to that alert code will populate in the Maintenance section to

the right.

l
Highlight an alert code and press DELETE or click the Delete icon if you would

like to delete an alert code.

l You cannot delete an alert code that is attached to a parking ticket.

l
Press INSERT or click the Create icon if you would like to create a new alert

code. This will create a new line item in the left section of the window and the fields

in the Maintenance section will be enabled to enter the alert code information.

2     Create a new alert code.

l Enter a unique Alert Code. Once the new alert code is saved, this field cannot be

edited.

l The alert code can be up to 20 characters long.
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l Enter a Description for the new alert code.

l This field can be up to 60 characters long.

l Specify the alert code Duration in days.

l The default start date for an alert code is the day it is attached to the parking

ticket. The alert code expiration date is the start date plus the Duration. This

value can be between 0 and 999.

l Enter a Comment on the alert code.

l The Comment will display when the alert is activated. The field can be up to

1024 characters.

l Check the Selection Alert toggle to activate the alert message when the parking

ticket is individually selected for batch process, such as PT Past Dues.

l The selection alert will not activate if the account is included in a batch as a

member of a group select during a batch generate step.

l Check the Maintenance Alert toggle to activate the alert message when the park-

ing ticket is opened from any window where the ticket details can be maintained or

edited.

l Check the CR Receipt Alert toggle to activate the alert message when the parking

ticket is selected from the CR Cash Entry search window.

l
Click the Save icon to save the new alert code.
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PT> Maintenance> Credit Type

Create Credit Types in PT

Summary

Credit types are used to apply a credit to a fee on an existing parking ticket without impact-

ing the General Ledger. Credit types can be attached to parking tickets in the Parking Tick-

ets Maintenance window (PT> Maintenance> Parking Tickets> History tab> Add a Credit

icon ). Follow this process to create a credit type.

Step by Step

1     Open the Credit Type Maintenance window. 

l The Credit Type Maintenance window (PT> Maintenance> Credit Type) will dis-

play a list of all the credit types created in the application.

l
Click the Delete icon to delete a credit type.

l You cannot delete credit types that have been attached to parking tickets.

l
Click on the Create icon to add a new credit type.
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2     Create a new credit type. 

l Enter a unique Credit Type code. This code can be up to 8 alphanumeric char-

acters.

l This field will not be enabled and available for editing after the credit type has

been saved.

l Enter a description in the Description field. The Description can be up to 60 alpha-

numeric characters.

l Check the Disabled toggle to disable the credit type.

l Disabled credit type will not populate the selection window when a user

attempts to attach a credit type to a parking ticket. This allows you to disable a

credit type that should no longer be used without being forced to delete the

credit type.

l
Click on the Save icon or press ENTER to save the credit type.
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PT> Maintenance> Fees

Create a Fee in PT

Summary

The Fee Maintenance window is used to create and maintain fee codes. These fee codes

are then attached to parking tickets in order to levy parking fines. Follow this process to cre-

ate a parking ticket fee.

Step by Step

1     View the existing PT fees. 

l The Fee Selection window (PT> Maintenance> Fees) displays all of the fees cre-

ated in the PT Module.

l
Highlight a fee and click the Delete icon or press DELETE to delete the selected

fee.

l Fees that are attached to parking tickets or other fees as penalty fees cannot

be deleted.
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l
Highlight a fee and click the Modify icon to edit the selected fee.

l
Click the Create icon to open the Fee Maintenance window.

2     Create a new fee. 

l Enter a unique Fee Code for the new fee.

l This field can accommodate up to 8 alphanumeric characters. Once the fee

has been saved, this field cannot be edited.

l Enter an optional Description for the fee.

l This field can accommodate up to 60 alphanumeric characters and will be dis-

played on the parking ticket when the citation is issued.

l Select the Fee Type from the drop-down menu.

l Select Standard if you would like to create a standard flat rate fee that will be

levied when a parking ticket is issued. This will enable the Fixed Amount field

below.

l Select Penalty if you would like to create a fee that can be used to penalize

individuals that have failed to pay parking tickets by the specified due date.

This will enable the Rates section below.

l Enter an amount in the Fixed Amount field if you are creating a standard fee. This

fee code will be used for a transaction that is usually the same dollar amount.

l This field is only enabled when creating a Standard fee.
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l Enter a Payment Priority or click the field label to choose one from a list. This is a

required field.

l Payment priority codes determine the order in which fees are paid. Payment

priorities are created and maintained on the Payment Priority Maintenance

window (PT> Maintenance> Payment Priority).

l Attach a Revenue Account and Cash Account to the fee. These accounts must be

designated in order to create the fee.

l If you would like to attach a Penalty Fee to the new fee, enter one in the Penalty

Fee field or click the field label to choose one from a list. Penalty fees are generally

attached to PT fees to assess penalties on delinquent parking tickets.

l If the Fee Selection window does not display a penalty fee, you will need to

create one before it can be attached to another fee. This field will only be

enabled when creating a standard fee.

l The Disabled toggle is used to retire a fee from use without deleting it.

l If this toggle is checked, the fee will not be available when issuing a parking

ticket. This toggle is unchecked by default.

3     Add rates to a penalty fee. 

l The Rates section of the Fee Maintenance window is used when creating a penalty

fee. This section will not be enabled when creating a standard fee.

l
Click the Create icon to create a new rate line item.

l Enter the range values in the Greater Than and Through fields.
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l These values will designate the lower and upper limits of each penalty fee tier.

l For example, a three-tier late fee might include ranges of 0 - 15 days, 15 - 30

days and 30 - 45 days. In this case, you would need to create a new rate line

item for each of these ranges. The high limit a lower tier should match the low

limit of the next tier.

l Check the Or Over toggle if you want the range to apply to unit values that are

greater than the upper range entered in the Through field.

l Enter a Rate for the fee.

l The percentage in the Rate field will be multiplied by the past due amount.

l
Click the Save icon when complete.
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PT> Maintenance> Forms

Forms Maintenance

Summary

Forms refer to Microsoft Word documents that, through the use of merge fields, allow users

to pull data from the application and customize how that data is displayed on the forms.

Forms will be saved in the Springbrook folder on your server at the path specified when the

application was installed (SS> Utilities> System Setup> System tab> Archive Directory

field).

The forms will be saved as .sbw files in this folder and should not be edited to avoid cor-

ruption. Forms can be attached to various application elements through the module pro-

cess and maintenance palettes.

Follow this process to create forms to attach to Parking Tickets processes. The forms set

up in the PT module will not be accessible in other modules that use forms.

Step by Step

1     View the existing Forms. 
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l Open the Word Merge Form Selection window (PT> Maintenance> Forms).

l The Word Merge Form Selection window will display all of the forms created in the

application. Use the search criteria fields to filter the displayed forms.

l
Highlight a form and click the Preview icon to view the selected form. This will

open the MS Word document in a new window.

l
Highlight a form and click the Copy icon to copy the selected form. This will cre-

ate a copy of the original form.

l
Highlight a form and click the Delete icon or press DELETE to delete the selec-

ted form.

l
Highlight a form and click the Modify icon or press ENTER to open and edit an

existing form.

l
Click the Create icon or press INSERT to create a new form. This will open the

Word Merge Form Maintenance window.

2     Create a new Form. 

l Enter a unique Form Name for the form. The field can be up to 32 characters long.

Once the form has been saved, you will not be able to edit this field.

l Enter an optional form Description.

l The System field will default to PT and cannot be edited.
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l Select the Process that the new form will be used in.

l This form will only be available in the process selected in this drop-down

menu.

l
After you have entered the form details, click the Create icon to create the form.

This will open a new Word document.

l Once the Word document is open, use the insert merge fields command in

Word to specify the data fields you want displayed on the form. For instance,

the merge field Citation_Number is the citation number recorded on the park-

ing ticket. By inserting this merge field into the Word document, and then

attaching the form to a PT process, the form will display the data found in the

citation number field of the parking ticket included in the process.

l NOTE: When creating a form that includes fee data, you must use the Fee_

SectionStart and Fee_SectionEnd merge fields before and after the other fee

merge fields will display.

l Images, charts, tables, etc. can also be inserted into the Word document.

l Once you are finished creating/modifying your form, be sure to save the form both

on the Word document (File> Save) and using the Save icon on the Form Main-

tenance window.

l The new form will now be available when creating form letters in the specified PT

process.
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PT> Maintenance> Location

Create a Location in PT

Summary

Location codes are used to organize parking tickets by the physical locations where they

are issued.

If you would like to locate all of the parking tickets attached to a location, use the Parking

Tickets Report filtered by that location (PT> Reports> Parking Tickets).

Step by Step

1     View the locations set up in the PT module. 

l Open the Locations Maintenance window (PT> Maintenance> Locations).

l The Locations Maintenance window will display all of the locations that have been

set up in the module.

l Highlight a location in the left section of the window and the fields in the Main-

tenance section will populate with the information attached to the selected record.
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l
Click the Delete icon or press DELETE to delete the selected location.

l You will not be able to delete a location that is attached to a parking ticket.

Locations are attached to parking tickets on the Parking Ticket Maintenance

window (PT> Maintenance> Parking Tickets> General tab> Location field).

l
Click the Create icon or press INSERT to create a new location. This will create

a new line item in the left section of the window.

2     Create a new location. 

l Enter a unique Location code. This code can be up to 8 alphanumeric characters.

l This field will not be enabled and available for editing after the location has

been saved.

l Enter a description in the Description field. The Description can be up to 60 alpha-

numeric characters.

l Check the Disabled toggle to disable the location.

l Disabled locations will not populate the selection window when a user

attempts to attach a location to a parking ticket.

l
Click on the Save icon or press ENTER to save the location.
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PT> Maintenance> Officer

Create an Officer in PT

Summary

Officers can be attached to parking tickets in order to track which individual issued each

parking ticket. The Officer Maintenance window is used to record the officer details.

Step by Step

1     View the Officers set up in the application.

l The Officer Selection window (PT> Maintenance> Officer) will display all of the

officers that have been set up in the application.

l Enter information in the fields in the Search Criteria section of the window and click

the Refresh icon to filter the officers that will display in the window.

l
Highlight an officer and click the Delete icon to delete the selected officer.

l An officer that is associated with an existing parking ticket cannot be deleted.

l
Highlight an officer and click the Modify icon to open an existing officer.
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l
Click the Create icon to create a new officer. This will open the Officer Main-

tenance window.

2     Create a new officer. 

l The Officer Maintenance window is used to record the officer details.

l The Officer Number field will automatically populate with the next available officer

number. This field cannot be manually edited.

l Only the Last Name, First Name and Badge Number fields are required. Enter

this information, as well as any other desired details, and click the Save icon to

save the new officer.
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PT> Maintenance> Parking Tickets

Create a Parking Ticket

Summary

The parking ticket is the central entity in the Parking Ticket module. Follow this process to

create a parking ticket.

Step by Step

1     View the existing Parking Tickets. 

l Open the Parking Ticket Selection window (PT> Maintenance> Parking Tickets).

l The Parking Ticket Selection window displays all the parking tickets previously cre-

ated in the application.

l
Highlight a parking ticket and press DELETE or click the Delete icon to delete a

ticket.

l A parking ticket that has been associated a transaction cannot be deleted.

l
Highlight a parking ticket and press ENTER or click the Modify icon to edit the

selected parking ticket.

CREATE A PARKING TICKET 38



l
Press INSERT or click the Create icon to create a new parking ticket. This will

open the Parking Tickets Maintenance window.

2     Create a new Parking Ticket. 

l The General tab is used to record the general parking ticket information.

l Enter a unique Citation Number for the parking ticket.

l This is the number that will be used to track the parking ticket details. Many cit-

ies use the numbers printed on the citations notepads used by parking

enforcement officers. This is a required field.

l Enter a ticket Status or click the field label to select one from a list.

l The status field is a user-defined field that allows you to categorize your park-

ing tickets in order to identify their standing. This is a required field.

l The Past Dues, Collections, and Excessive Tickets process can all change

parking tickets to unique statuses.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l The Status Description field will automatically populate with the description

specified on the status selected above.

l Enter the Citation Date and Citation Time that the parking ticket was created.

l Enter the Location where the citation was issued or click the field label to select

one from a list.
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l Locations are created and maintained on the Location Maintenance window

(PT> Maintenance> Location).

l Enter the Court Date and Court Time when the recipient can contest the parking

ticket.

l The Comments field is used to add any desired comments to the parking ticket.

This field can accommodate up to 512 alphanumeric characters.

l The Excessive Date field and Excessive tickets toggle will automatically update if

the ticket is included in an Excessive Tickets batch (PT> Excessive Tickets).

l Enter the Vehicle Number that is being cited or click the field label to select a

vehicle from a list. This is a required field.

l The vehicle code contains all of the vehicle details that will populate the fields

below. If the vehicle number does not already exist, you can click the field

label to open the Vehicle Selection window and then click the Create icon

to add the vehicle to the database.

l Vehicles are created and maintained on the Vehicle Maintenance window

(PT> Maintenance> Vehicle).

l Enter the Officer Number for the officer that issued the citation or click the field

label to select an officer from a list.

l The Officer Name and Officer Badge fields will populate with the details

attached to the selected officer number.

l Officers are created and maintained on the Officer Maintenance window (PT>

Maintenance> Officer).

l The Status Change History field will display a line item for each time the parking

ticket status changes.
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l The Include Payments drop-down menu is used to specify if the financial details

displayed below include all payments or only committed payments.

l The Total Fees, Total Paid and Balance fields will display the current financial

details associated with the ticket.

l The Fees field is used to attach fees to the parking ticket. required.

l Only standard fees can be added or removed from here. Penalty fees are

added to the parking ticket during the Past Dues and Collections batch pro-

cesses.

l PT fees are created and maintained on the Fee Maintenance window (PT>

Maintenance> Fee).

3     Complete the Person tab. 

l The Person tab is used to attach a person and/or an existing Springbrook customer

to the parking ticket.

l Enter a Person Number or click the field label to select one from a list.

l The details attached to the selected person will populate the fields below.

l People are created and maintained on the Person Maintenance window (PT>

Maintenance> Person).

l Enter a Customer Number or click the field label to select one from a list.

l The details attached to the selected customer will populate the fields below.

l Customers are created and maintained on the Customer Maintenance win-

dow (SS> Maintenance> Customer).

CREATE A PARKING TICKET 41



4     Complete the History tab. 

l The History tab is used to track the transaction history and attach credit types to

the parking ticket. This window will display every transaction recorded against the

parking ticket. These transactions include credit types, which are attached to park-

ing tickets in order to affect the ticket balance without impacting the General

Ledger.

l Credit types are created and maintained on the Credit Type Maintenance win-

dow (PT> Maintenance> Credit Type).

l
Click the Create icon to attach a credit type to the parking ticket. This will open

the Credit Type Selection window.

l
Select a credit type and click the Confirm icon to add that selected credit

type to the parking ticket. This will enable a new line item in the Credit Details

section at the bottom of the History tab.

l Specify an Amount for the new credit type line item. The amount specified

cannot exceed the remaining balance on the parking ticket.

l Once the parking ticket is saved, the credit type amount will appear as a payment in

the Fees field of the General tab and the ticket balance will reflect this payment.

l You can also remove a credit type from a parking ticket by highlighting the credit

type and click the Delete icon .

5     Complete the Alert tab. 
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l The Alert tab will display all of the existing alerts attached to the parking ticket.

l
Highlight an alert code and click the Delete icon or press DELETE to remove the

selected alert code from the ticket.

l
Highlight an alert code and click the Modify icon or press ENTER to edit the

selected alert code.

l
Click the Create icon or press INSERT to attach a new alert code to the parking

ticket. This will open the Alert Code Selection window.

l
Select an alert code and click the Confirm icon to add the selected alert

code to the ticket.

l Alert codes are created and maintained on the Alert Code Maintenance win-

dow (PT> Maintenance> Alert Code).

l The Description field will automatically populate with the description attached to

the selected alert code.

l Enter an Alert Date for the new alert code. This represents the date that the alert

code becomes active.

l This field will automatically populate with today's date.

l The Expiration Date is calculated by adding the alert duration specified on the

selected alert code to the date specified in the Alert Date field. If the Alert Date is

updated, the Expiration Date will automatically update according to this calculation.

l The Expiration Date cannot be prior to the Alert Date.

l The Comment field will populate with the comment attached to the selected alert

code but can be edited.
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l Check the Selection Alert toggle to activate the alert message when the ticket is

individually selected for a batch processes such as PT Collections.

l The selection alert will not activate if the ticket is included in a batch as a mem-

ber of a group select during a batch generate step.

l Check the Maintenance Alert toggle to activate the alert message when the ticket

is opened from any window where the ticket details can be maintained or edited.

l Check the CR Receipt Alert toggle to activate the alert message when the ticket is

selected from the CR Cash Entry search window.

6     Complete the Miscellaneous tab. 

l The Miscellaneous tab allows you to build your own tables of data if there is inform-

ation you want to track. This information is optional and user-defined.

l Miscellaneous field labels are maintained on the Miscellaneous Field Label Main-

tenance window (SS> Utilities> Miscellaneous Field Labels).

l
Click the Save icon when the parking ticket is complete.

7     Track any changes made to the parking ticket record. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit history.
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l The Audit Trail section will provide details about any changes made to the parking

ticket record including the date of the change, type of change made, user that made

the change, and data table that was edited.
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PT> Maintenance> Payment Priority

Payment Priorities Maintenance

Summary

Payment priority codes determine the order in which fees are paid. Fees attached to higher

priority levels will be paid in full before fees attached to lower priority levels. If there is not

enough money to pay a certain level of priority, the system will allocate the payment across

all the fees with the same priority level.

Step by Step

1     Open the Payment Priority Maintenance window. 

l The Payment Priority Maintenance (PT> Maintenance> Payment Priorities) win-

dow will display a list of all the payment priority codes created in the application.

l
Click the Delete icon to delete a payment priority code. You cannot delete pay-

ment priority codes that are attached to existing fees.

l
Click on the Create icon to add a new payment priority code.
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2     Create a Payment Priority Code. 

l Enter a payment priority code in the Code field. This Code can be up to 10 alpha-

numeric characters. This field will not be enabled and available for editing after the

payment priority code has been saved.

l Enter a description in the Description field. The Description can be up to 60 alpha-

numeric characters.

l Enter a Priority for the code. The priority can range from 00, the highest priority, to

99, the lowest priority.

l
Click on the Save icon or press ENTER to save the payment priority code.
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PT> Maintenance> Person

Create a Person in PT

Summary

A person can be attached to the Person tab of the Parking Tickets Maintenance window

(PT> Maintenance> Parking Tickets> Person tab> Person Number field). You can create

people as the citation is created, or you can create them using the Person Maintenance win-

dow.

Step by Step

1     View the People set up in the application. 

l The Person Selection window (PT> Maintenance> Person) will display all of the

people that have been set up in the application.

l Enter information in the fields in the Search Criteria section of the window and click

the Refresh icon to filter the people that will display in the window.

l
Highlight a person and click the Delete icon to delete the selected person.

l A person that is associated with an existing parking ticket cannot be deleted.
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l
Highlight a person and click the Modify icon to open an existing person.

l
Click the Create icon to create a new person. This will open the Person Main-

tenance window.

2     Create a new Person. 

l The Person Maintenance window is used to record the person details.

l The Person Number field will automatically populate with the next available person

number. This field cannot be manually edited.

l Only the Last Name and First Name fields are required. Enter this information, as

well as any other desired details, and click the Save icon to save the new per-

son.
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PT> Maintenance> Status

Create a Status in PT

Summary

The Status Maintenance window is used to create and maintain statuses. A status is a

user-defined code used to describe the current state of a parking ticket.

Statuses are attached to parking tickets on the Parking Ticket Maintenance window (PT>

Maintenance> Parking Ticket> General tab> Status field). Statuses can also be set up to

automatically update after a parking ticket is processed through a PT batch. Those default

statuses are specified on the PT Setup window (PT> Utilities> Setup).

Follow this process to create a new PT status.

Step by Step

1     View the statuses set up in the PT module. 
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l Open the Ticket Status Maintenance window (PT> Maintenance> Status).

l The Ticket Status Maintenance window will display all of the statuses that have

been set up in the module.

l Highlight a status in the left section of the window and the fields in the Maintenance

section will populate with the information attached to the selected record.

l
Click the Delete icon or press DELETE to delete the selected status.

l You will not be able to delete a status that is attached to a parking ticket.

Statuses are attached to parking tickets on the Parking Ticket Maintenance

window (PT> Maintenance> Parking Tickets> General tab> Status field).

l
Click the Create icon or press INSERT to create a new status. This will create a

new line item in the left section of the window.

2     Create a new status. 

l Enter a unique Status code. This code can be up to 8 alphanumeric characters.

l This field will not be enabled and available for editing after the status has

been saved.

l Enter a description in the Description field. The Description can be up to 60 alpha-

numeric characters.

l Check the Disabled toggle to disable the status.

l Disabled statuses will not populate the selection window when a user

attempts to attach a status to a parking ticket.
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l
Click on the Save icon or press ENTER to save the status.
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PT> Maintenance> Vehicles

Vehicle Maintenance

Summary

The Vehicle Maintenance window is used to record the registration and description details

associated with a vehicle being cited.

Step by Step

1     Open the Vehicle Selection window (PT> Maintenance> Vehicle). 

l The Vehicle Selection window will display all of the vehicles that have been cre-

ated in the system.

l Enter any desired vehicle details in the Search Criteria section and click the Refresh

icon to filter the displayed vehicles.

l
Highlight a vehicle and click the Delete icon or press DELETE to delete the

selected vehicle.

l You will not be able to delete a vehicle that is attached to a parking ticket.

Vehicles are attached to parking tickets on the Parking Ticket Maintenance
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window (PT> Maintenance> Parking Tickets> General tab> Vehicle Number

field).

l
Click the Create icon or press INSERT to create a new vehicle. This will launch

the Vehicle Maintenance window.

2     Create a new vehicle record. 

l The Vehicle Number field will automatically populate with the next available

vehicle number when the new vehicle is saved. The field cannot be edited.

l Enter the Tag Number and select the Tag State for the vehicle.

l These are the only two required fields on the Vehicle Maintenance window.

l Enter the Tag Expiration date

l Enter the VIN (vehicle identification number) for the vehicle.

l Enter any additional vehicle details in the Year, Make, Model, Type and Color

fields.

l
Click the Save icon when all the desired vehicle details are entered.
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PT> Past Dues

Process Past Dues

Summary

The Past Dues batch process will charge late fees on the violations attached to a parking

ticket, automatically update the status of selected parking tickets, and generate past due

form letters.

Step by Step

1     Open a Past Dues batch or create a new one. 

l Select the Past Dues palette in PT> Past Dues. This will expand the Past Dues

palette and display the steps of the batch process.

l Modify an existing batch or create a new Past Dues batch.

l Select a batch number from the drop-down menu at the top of the Past Dues

palette to select an existing batch.

l Select New from the Past Dues batch number drop-down menu to create a

new batch. This will open the New Batch window.
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l If there are open batches in the Past Dues process, you can create a new

batch without affecting the open batches.

l Enter a Batch Month and Batch Year. These fields default to the current cal-

endar period and are for reference only. The fiscal period of the transactions

in the batch is determined by the transaction date entered during the Gen-

erate step.

l
Click the Generate icon to populate the Batch Number field with the next

available batch number. Batch numbers are limited to five digits and must be

unique within the batch month of the batch year.

l You can also manually create a new batch by entering a Batch Number

and clicking the Save icon .

l Highlight the batch in the batch number drop-down menu on the Past Dues palette

and press DELETE to delete a batch. Any uncommitted transactions in the batch

will be deleted.

2     Generate the Past Dues batch. 

l Open the Generate Past Dues window (PT> Past Dues> Generate).

l Check the Fee toggle for each fee you would like to send to Past Dues.

l
Click the Select All or Deselect All icon drop-down menus to select or

deselect all of the displayed Fees. All Fees are selected by default.

l These icons can be used to select or deselect the Statuses as well.
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l Fees are created and maintained on the Fee Maintenance window (PT> Main-

tenance> Fees).

l Check the Status toggle for each status you would like to send to Past Dues.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l Specify a Tran Date for the Past Dues batch. This date will be used by the Letter

and Penalty transactions created when the batch is committed.

l Specify an Aging Date for the batch.

l The Aging Date is the date the system will use in conjunction with the Min-

imum Age and Maximum Age fields to determine which tickets are to be put

into Past Dues status.

l For example, if 10/15/15 was entered as the Aging Date, and 30 and

999 are entered in the Minimum/Maximum fields, all citations with a

date older than September 15th (30 days old) would be selected to for

the Past Dues batch.

l Enter a New Ticket Status or click the field label to select a status from a list.

l This is the status that will be automatically assigned to any citations included

in the Past Dues batch. This will default to the Past Dues status specified on

the PT Setup window (PT> Utilities> Setup> Past Dues Status field).

l The Filter tab is used to filter the citations that will be included in the Past Dues

batch.

l The Minimum Age and Maximum Age fields are used to filter the included

citations by their age in relation to the Aging Date specified above.
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l The Minimum Status Age field is used only by the Collections process and is

disabled here.

l The Ticket tab is used to add specific parking tickets to the Past Dues batch.

l
Click the Create icon to select specific parking tickets to include in the

batch. This will launch the Parking Ticket Selection window.

l
Filter the displayed tickets and click the Confirm icon when you have

made your selection. You can use the CTRL or SHIFT keys to select multiple

tickets.

l Manually selecting parking tickets to include in the batch will override any fil-

tering details specified on the Filter tab.

l
Click the Save icon when compete.

3     Edit the Past Dues. 

l Open the Edit Past Dues window (PT> Past Dues> Edit).

l The Ticket tab of the Edit Past Dues window displays all of the tickets that will be

included in the Past Dues batch.

l Click a citation number to open and edit the included ticket.

l
Highlight a ticket and click the Delete icon to remove the ticket from the

batch.
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l The Errors tab will display any tickets that meet the filter requirements specified in

the Generate step but cannot be included in the Past Dues batch. The Warning Mes-

sage column will display the reason that the ticket cannot be included in the batch.

Tickets that meet one of the following criteria cannot be included in a Past Dues

batch:

l Citation is in a pending Cash Receipts batch.

l Citation is in a pending Collections batch.

l Citation is in another pending Past Dues batch.

l Citation has outstanding fees but no associated penalties or penalties that do

not have billable rate tiers for the current number of days past due.

l Citation was manually included in the Past Dues batch but has no outstanding

balances that qualify for past dues penalties.

l
Click the Save icon when compete.

4     Print the Proof List. 

l Open the Past Dues Proof List window (PT> Past Dues> Proof List).

l Select a Report Type from the drop-down menu.

l The Summary report displays the Citation Number, Citation Date, Location,

Name, Vehicle Year, Make, Model, Tag Number, Tag Expiration Date and

Amount for each ticket. The report will also include a report total and the num-

ber of printable notices generated by the batch.
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l The Detail report displays everything included in the Summary report as well

as the specific late fee codes that will be charged when the Past Due batch is

processed.

l The detail report will display a new violation line item for every late fee

that will be applied to the violation.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

5     Print the Past Dues Letters. 
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l Open the Letters window (PT> Past Dues> Letters).

l Select a Form from the drop-down menu. If a default form is specified on the PT

Setup window (PT> Utilities> Setup> Past Dues Form field), that form will auto-

matically populate and this field will not be enabled.

l The format and information included in the Past Dues letters is determined by

which form is selected.

l Forms are created and maintained on the Forms Maintenance window (PT>

Maintenance> Form).

l The Tran Date field will populate with the transaction date specified in the Generate

step.

l The Compatibility mode toggle is used to activate compatibility mode for legacy

forms that don't use standard Springbrook forms functionality.

l Springbrook does not recommend using Compatibility mode as it will disable

a number of useful form features.

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.

l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.
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l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).

6     Commit the Past Dues batch. 

l Open the Commit window (PT> Past Dues> Commit).

l Click OK to commit the batch.

l If a citation included in the Past Dues batch has been added to a Cash

Receipts batch between the time when the Past Dues batch was generated

and when you are attempting to commit the batch, a warning message will dis-

play and the batch will need to be regenerated.

l Once the batch is committed, the status of the tickets included in the batch will be

updated to the Past Dues status specified on the Generate step.
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PT> Reports> Parking Tickets

Parking Tickets Report

Summary

The Parking Tickets report provides a filtered list of parking tickets.

Step by Step

1     Open the Parking Tickets report (PT> Reports> Parking Tickets).

2     Configure the report. 

l Check the toggle next to each Location you would like to include in the report.

l
By default, all locations will be selected. You can use the Select All or

Deselect All icons to select or deselect all the displayed locations.

l Locations are created and maintained on the Location Maintenance window

(PT> Maintenance> Location).
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l Check the toggle next to each Status you would like to include in the report.

l By default, all statuses will be selected.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l The Layout tab is used to specify how the report will be displayed.

l Check the Include citations, Include fees, Include person and Include

vehicle toggles to include that information in the report.

l The General, Excessive Tickets and Past Due tabs are used to filter the included

parking tickets by the fields displayed on those tabs.

l Depending on how the Layout tab is configured, the report will display the Citation

Number, Date, Status, Location, Vehicle, number of Tickets, Amount, Payments,

and Balance. A report total will also be provided.

3     Print the report. 

l
Click the Print icon to process the report immediately or enter a date and time in

the field next to the Print icon to schedule the report to generate at a later time. You

can view the progress of the report on the Job Viewer window (SS> Utilities> Show

Scheduled Jobs).

l Click the Print icon drop-down menu and select Print Preview to preview the

report before printing.

l Click the Print icon drop-down menu and select Excel to export the report data

to an Excel spreadsheet as unformatted data.
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l Click the Print icon drop-down menu and select Excel (Formatted) to export

the report data to an Excel spreadsheet that includes much of the Spring-

brook formatting found on the printed version of the report.

l Once the report is generated, you can also display the report using the View

Reports window (SS> Utilities> View Report).
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PT> Utilities> Setup

Set up the Parking Tickets Module

Summary

Follow this process to set up the Parking Tickets module.

Step by Step

1     Open the Parking Ticket Setup window (PT> Utilities> Setup).

2     Setup the Parking Tickets module. 

l The Max Letters Per Recipient field is used to specify the maximum number of let-

ters that can be sent to a single recipient included in a PT batch process.

l Specify which Form will be the default letter generated during the Letters step of the

Past Due, Collections and Excessive Tickets processes.

l The forms specified in these fields are Microsoft Word documents that,

through the use of merge fields, allow users to pull data from the application

and customize how that data is displayed on the forms.
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l Forms are created and maintained on the Forms Maintenance window

(PT> Maintenance> Forms).

l The form letters specified here are only default letters. Different letters can be

specified every time you run a PT batch process letter step.

l The Excessive Ticket Tow Days and Tow Ticket Count fields are only used by organ-

izations that have purchased Springbrook's optional Mobile Parking Violation Inter-

face. Springbrook partners, such as Quatred, have developed hand-held parking

ticket software that communicates with Springbrook's Parking Tickets module

through this interface, allowing parking officers to enter and print tickets remotely. If

your organization does not use the Mobile Parking Violation Interface, these fields

will not affect the application.

l The Excessive Ticket Tow Days field is used to specify the number of days

that an outstanding ticket must be marked as excessive before it is included

on the Tow List.

l The Tow Ticket Count field is used to specify the number of tickets that must

be issued to a vehicle for that vehicle to be included on the Tow List.

l To learn more about the Mobile Parking Violation Interface, please con-

tact Springbrook at 866-256-7661 or sales@sprbrk.com.

l The Collections Alert field is used to specify the alert that will be added to any cita-

tion that is processed through a collections batch.

l Alert codes are created and maintained on the Alert Code Maintenance win-

dow (PT> Maintenance> Alert).

l The Status fields are used to specify the default statuses associated with citations

at various stages of the citation life cycle. Citations can be set up to automatically

update to a specified status when they are successfully processed through a PT
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batch process.

l The New Ticket Status field is used to specify the default status for all newly

created tickets.

l The Past Due, Collections and Excessive Tickets Status fields are used to

specify the status of any citation processed through one of these batch pro-

cesses. Once processed, the status associated with any citation included in

the batch will update to the status specified here.

l The Pay Off Status field is used to specify the status that will be associated

with citations after they have been paid off.

l The Pay Collections Status field is used to specify the status that will be asso-

ciated with citations that have been processed through a collections batch

and then paid in full in Cash Receipts.

l
Click the Save icon when the setup is complete.

3     Track any changes made to the PT Setup window. 

l
Click the Audit Trail icon to open the Audit Trail window.

l Use the Search Criteria section to sort the displayed audit trail.

l The Audit Trail History section will provide details about any changes made to the

setup window including the date of the change, type of change made, user that

made the change, and data table that was edited.
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PT> Utilities> Import/Export Parking
Tickets

Import and Export Parking Tickets

Summary

The PT Import and Export Parking Ticket windows allow you to import citations from a PDA

or export citations to create a tow list. Follow this process to import parking tickets or create

the export files.

Step by Step

1     Import parking tickets. 

l Open the Import Parking Tickets window (PT> Utilities> Import Parking Tickets).

l Enter a File Name path or click the field label to browse to the import file.

l The import file must be in comma-separated value (.csv) format.

l
Click the Display icon to display the expected .csv file layout.

l The expected import will include the Record Type, Citation Number, Cit-

ation Date/Time, Vehicle Tag Number, Tag State, Tag Expiration Date,
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Vehicle Make, Model and Color, Citation Location, and Officer Badge

Number as separate columns on the .csv spreadsheet.

l Enter the Status that the imported parking tickets will be assigned.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l
Click the Confirm icon to import the parking tickets.

2     Export parking tickets files. 

l Open the Export Parking Tickets window (PT> Utilities> Export Parking Tickets).

l Select each Status that you would like to include in the export file. 

l
Click the Select All or Deselect All icon to select or deselect all of the

displayed statuses. All statuses are selected by default.

l Statuses are created and maintained on the Status Maintenance window

(PT> Maintenance> Status).

l TheWaiting Period field is used to specify a waiting period for any excessive tick-

ets you would like to include in the export.

l For example, enter 30 if you would like the tow list to include any vehicles that

have been in excessive ticket status for over 30 days. Any vehicles in excess-

ive ticket status for less than 30 days would not be included in the export file.

l Check the Include all excessive tickets toggle to include all the excessive tickets

in the system in the export files.
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l Checking this toggle will override the Waiting Period specified above.

l
Click the Confirm icon to generate the .dat export files.

l Once the export has finished processing, the Export Settings window will open.

This window is used to specify the export path for the violations, locations and tow

list for the exported tickets.

l The Violations .dat export file includes the fee details associated with the

included citations. These details include the fee identification number, the fee

code, the fixed amount of the fee, and the late fees associated with the fee.

l The Locations .dat export file includes the location details associated with the

included citations. These details include the location identification number,

the location code, and the location description.

l The Tow List .dat export file includes the vehicle tag details associated with

the included citations. These details include the vehicle tag number and tag

state.

l Check the Open toggles if you would like to open the exported files after they are

saved locally.

l
Enter the export path locations and click the Save icon to export the files to the

local paths.
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